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Section 1: General Information

Introduction
Trace600 is a Windows®-based application designed to view, analyze, edit, and print trace files 
saved with M600 Mini-OTDR, M100 Handheld OTDR, and OFL 200 Handheld OTDR.

Note: Trace600 is not licensed software; you are free to copy it as needed. Please check our 
web site at www.AFLtele.com (click on Products >Noyes Test & Inspection > Software) 
for software updates and additional application information.

This User’s guide contains detailed information about Trace600 tools and commands and assumes 
you have a working knowledge of your computer and standard Windows menus & commands. For 
help with any of these techniques, please see your Windows documentation.

If you have any questions about your OTDR and Trace600 software, or if you need technical or 
sales support, please contact Noyes Customer Service.

Contacting Noyes Customer Service
You may call Noyes Customer Service between 8 a.m. and 5 p.m., United States Eastern Time, 
as follows:

Phone: 800-321-5298 (North America)

 603-528-7780

Fax: 603-528-2025

Web: www.AFLtele.com (click on Products > Noyes Test & Inspection)
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System Requirements
To use Trace600 application, you need the following hardware and software:

• A 400 MHz (or faster) personal computer or laptop with an 800 x 600 (or larger) display

• A CD-ROM drive

• At least 32 megabytes (MB) of RAM

• A Windows compatible pointing device (mouse, trackball, etc.)

• MS Windows 9X, 2000, XP, or NT 4.0

Installing Trace600
You can install Trace600 from the supplied CD-ROM, or you can download it from our web site at 
www.AFLtele.com (click on Products > Noyes Test & Inspection > Software).

If you have an old version of Trace600, uninstall it first. Follow the steps below to install the 
Trace600 software.

To install from the application CD-ROM:

1 Start Windows®. If Windows is running, quit all applications.

2 Insert the Trace600 CD into the CD-ROM drive. (Note: normally the D: drive.)

3 The InstallShield® Wizard will display the [Welcome] screen.

 Note: If the InstallShield Wizard does not start automatically, from Windows do one of the 
following:
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• - Click on the [Start] button and select the [Run] command from the pop-up menu.

 - The [Run] dialog box appears. On the [Open] command line, type [D:\setup.exe].

 - Click on the [OK] button to start.

OR

• - Double-click the My Computer icon on the desktop to open the My computer folder.

 - Double-click the CD-ROM icon.

 - Double-click [Setup.exe] in the T600v2 folder.

4 When the InstallShield® Wizard [Welcome] screen is displayed, click on the [Next] button to 
continue.

5 Follow the on-screen instructions.

6 When the InstallShield Wizard displays the [Complete] screen, click on the [Finish] button.

To download from the web:

1 From the www.AFLtele.com web site, select the following:

 Products > Noyes Test & Inspection > Software > Trace 600 PC Software > click on the 
download icon.

2 Follow the on-screen instructions. The software will download to your computer’s hard drive. 

3 Once downloaded, double-click on the [T600v2.exe] file.
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4 When the InstallShield® Wizard [Welcome] screen is displayed, click on the [Next] button to 
continue.

5 Follow the on-screen instructions.

6 When the InstallShield Wizard displays the [Complete] screen, click on the [Finish] button.

Starting Trace600

Follow the steps below to start the Trace600 application: 

1 In Windows, click on the [Start] button.

2 From the [Start] pop-up menu, select the [Programs] menu.

3 Locate the Noyes Fiber Systems folder.

4 Click on the Trace600 shortcut.

If you have installed the Trace600 application in a folder other than Noyes Fiber Systems, choose 
that folder from the Start > Programs menu.

Note: To see filename extensions that show fiber type and wavelength (m85, m13, s13, s15,  
m85.sor, m13.sor, s13.sor, s15.sor) when browsing for trace files, perform the following steps:

1 From Windows (not Trace600), open the folder containing trace files.

2 Open the [View] dialog box by clicking on Tools > Folder Options > View.

3 In the [Advanced Settings] window, remove the check next to the [Hide file extensions for 
known file types] option.

4 Repeat steps 1- 3 for other folders containing trace files.
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Section 2: Trace600 Screens and Menus
This section provides an overview of key features of the Trace600 software.

Main Screen
The Trace600 main screen is divided into several sections. Each section contains a specific 
type of information (refer to Figure 2-1). The table below gives a summary of the [Main] screen 
features.

Ref # Feature Description

1 Menu bar Displays the available pull down menus.

2 Toolbar Contains several icons for quick access to menu commands.
Click on an icon to execute the related command.

3 Zoom window Shows the size of the current view and the location of cursors 
relative to the entire trace.

4 Cursor data This section displays the following information: A and B cursor 
locations, distance from A to B, selected loss method, plus 
(depending on the selected loss method) insertion loss, event 
level data, and reflectance.

5 OTDR/Text data This section displays OTDR setup parameters or Text data when 
the corresponded tab [OTDR info] or [Text info] is selected.
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Figure 2-1: Trace600 Main Screen.
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6 [OTDR Info] tab Click on this tab to display OTDR setup parameters stored in the 
selected trace file.

7 [Text Info] tab Click on this tab to display text information stored in the selected 
trace file.

8 [Edit Trace Info] 
button

Click on this button to display the [Edit Trace Information] 
screen, which allows editing.

9 Vertical split bar This bar allows resizing of the [Trace graph] and [Event table] 
window vertically.
Drag the Vertical bar to the left or right to decrease or increase 
the [Trace graph] and [Event table] window.

10 Horizontal split bar This bar allows resizing of the [Trace graph] and [Event table] 
window horizontally.
Drag the Horizontal bar up or down to increase or decrease the 
[Trace graph] and [Event table] window.

11 [Event table] window Displays saved events in a table format.

12 [Trace graph] window Shows a graph of the currently selected trace. Up to four traces 
can be displayed in the [Trace graph] window.

13 Currently selected 
trace tab

If several trace files are opened, click a trace tab to display the 
desired trace graph.
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Menu Bar
The Menu Bar located at the top of the Trace600 Main Screen 
(see Figure 2-1) displays the available pull down menus. Each 
menu contains various commands. When a menu is selected, 
it displays a list of commands indicating a task associated with 
each command.

File Menu

You can find all the commands you need to open, save, print, 
edit, and close trace files on the File pull down menu. The table 
below gives a summary of the available File Menu commands 
and associated functions.

Command Function

Open Trace Ctrl+O Depending on the selected option 
(Single-wavelength or Dual-
wavelength), open a single trace file 
or a trace file pair.

Open Baseline Ctrl+B Depending on the selected option 
(Single-wavelength or Dual-
wavelength), open a single trace file 
or a trace file pair as a baseline.
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Menu Bar
The Menu Bar located at the top of the Trace600 Main Screen 
(see Figure 2-1) displays the available pull down menus. Each 
menu contains various commands. When a menu is selected, 
it displays a list of commands indicating a task associated with 
each command.

File Menu

You can find all the commands you need to open, save, print, 
edit, and close trace files on the File pull down menu. The table 
below gives a summary of the available File Menu commands 
and associated functions.

Command Function

Open Trace Ctrl+O Depending on the selected option 
(Single-wavelength or Dual-
wavelength), open a single trace file 
or a trace file pair.

Open Baseline Ctrl+B Depending on the selected option 
(Single-wavelength or Dual-
wavelength), open a single trace file 
or a trace file pair as a baseline.

Command Function

Next File Ctrl+N Open the next (alphabetically) file or pair in the current folder.

Prev File Ctrl+P Open the previous (alphabetically) file or pair in the current folder.

Close Ctrl+F4 Depending on the selected option for closing files, close selected 
files after automatically saving changes, or prompt the user to 
confirm saving.

Save Ctrl+S Save a trace file that already exists with its original name. 

Save As Save an existing trace file under a new name and preserve the 
original file.

Print Print the currently displayed trace.

Printer Setup Select a printer and set up printing options.

Batch Print Allows printing of all or selected trace files in the current folder.

Edit Trace Info Allows editing of trace text information and certain setup 
parameters.

Batch Edit Use to edit text or set up field(s) in multiple traces.

Transfer files from
OFL 200

Allows transferring files saved with an OFL 200 OTDR to a PC.

Exit Close opened trace files and exit Trace600.
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Events Menu

The Events pull down menu contains all the commands you will need to select loss methods, add 
new events, and review or delete saved events.
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The table below gives a summary of the available Events menu commands and associated 
functions.

Command Function

Add Event Ctrl+A Add an event using the selected Loss Method at the current 
cursor location.

Loss Method For analyzing traces and adding events, Trace600 offers 
various Loss Measurement Methods.

Current Event:
 •  Edit Comment 

 •  Delete

Open a dialog box for adding and/or editing comments for 
the current event. The maximum comment length is 94 
characters.

Delete the current event.

Next Event (Down Arrow) Display the next event.

Prev Event (Up Arrow) Display the previous event.

Delete All Events Shift+Del Delete all saved events in the selected trace.

Restore Event Shift+Insert Restore the last event that was deleted.

Restore LSA Defaults Restore LSA line lengths to the default values.
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View Menu

The View pull down menu contains all the commands you will need to magnify or reduce the display 
of any area in the [Trace graph] window, switch the active cursor, turn the Toolbar text on/off, 
and set up options. The table below gives a summary of the available View menu commands and 
associated functions.

Command Function
Zoom in Horizontally (Shift+Up Arrow)
Zoom out Horizontally (Shift+Down Arrow)

Zoom In Vertically (Ctrl+Up Arrow)
Zoom out Vertically (Ctrl+Down Arrow)
Un-Zoom F6
Re-Zoom  F7

Magnify or reduce the 
display of any area 
in the [Trace graph] 
window.

A-B Cursor F4 Switch the active 
cursor.

Toolbar Text Turn the Toolbar text 
on or off.

Options Open the [Options] 
dialog box for 
specifying Trace600 
options. See Fig. 2-2 
for details.
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Use the [Options] dialog box when you need to specify how to open and close trace files, how to 
close trace files with changes, and when you need to select distance units of measure.

Figure 2-2: Options Dialog Box.
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Turn Information Screen On/Off

Number of recently open files to be 
displayed under [File] menu
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Toolbar
Several of the most commonly used commands can be accessed from the Toolbar. Click on a 
toolbar icon to execute the corresponding command. 

  Locate and open the desired trace file.

Save a trace file that already exists with its original name.

Print the displayed trace file.

Open the Edit Trace Information dialog box.

Open the previous file (trace file pair) in the current folder.

Open the next file (trace file pair) in the current folder.

Zoom in horizontally around the active cursor.
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Zoom out horizontally around the active cursor.

Zoom in vertically from the trace level at the active cursor.

Zoom out vertically from the trace level at the active cursor.

Display the trace view at 100%.

Zoom to the previous zoom level around the active cursor.

Select the previous event.

Select the next event.

Switch the active cursor.
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Trace Graph Window

Figure 2-3: Trace Graph Window.
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The [Trace graph] window displays OTDR test results in a graph format. Up to four traces can be displayed 
in the [Trace graph] window. The major features of the [Trace graph] window are explained below.

Ref # Feature Description
1 Trace [Tab] Displays the name and color of the open trace file. If several trace files 

are opened, click the desired trace [Tab] to display the trace graph.
2 Vertical axis Shows Insertion loss in dB.
3 Horizontal axis Shows distance in user-selected units.
4 Trace This is a graph of insertion loss vs. distance.
5 Cursors A and B Used to measure insertion loss, power level, reflectance, attenuation, 

and distance. To make a cursor active, click on the cursor line or label, or 
click on the Toolbar Cursor icon to toggle between A and B cursors.
To move the active cursor, position the mouse pointer on a cursor, then 
click-and-drag along the trace graph. Also, you may use the Left and 
Right keyboard arrow keys.

6 Cursor label To move the active cursor, position the mouse pointer on a cursor label, 
then click-and-drag along the trace graph.

7 Event mark Indicates the location and number of a saved event. Events are ordered 
by the increasing location value.

8 LSA lines Available for certain loss measurement methods. Used for calculating 
insertion loss, trace level, and attenuation. 

9 LSA line 
boundaries

Near and Far LSA line boundaries for each LSA line segment. Used to 
control length and position (relative to trace segment) of LSA line.
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Event Table Window
The [Event table] window allows you to view test data associated with the trace displayed in the 
[Trace graph] window. If several trace files are opened, click the desired trace [Tab] located on top 
of the [Trace graph] window to display the [Event table] of the desired trace. Using the [Events] 
menu, you may add or delete trace events and edit comments.

Figure 2-4: Event Table Window.
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Features of the [Event table] window are explained below.

Ref # Feature Description

1 Overall data This row displays the overall trace data: number of saved events, link loss, 
and link length.

2 Event number This column displays a sequential numbers of the saved events. Events in 
the [Event table] are ordered by their increasing location value.

3 Atten.(dB/km) This column displays the lead-in fiber attenuation. The dB/km measurement 
is the slope of the fiber leading to the event 
Note:  When the length of the fiber being measured is insufficient, the 
dB/km measurement is displayed followed by an asterisk [*] symbol. An 
asterisk [*] symbol indicates, “Section is too short to ensure an accurate 
fiber attenuation (dB/ km) measurement.” The required minimum distance 
is dependant on wavelength: 1550 nm = 2630 m, 1310 nm = 1470 m, 
1300 nm = 960 m, and 850 nm = 185 m.

4 Loss (dB) This column displays the Insertion loss in (dB) of the fiber segment before 
the event.

5 Source This column indicates how the events is added:
• manually - added by operator, 
• automatically - event table is generated by OTDR

6 Type This column indicates the event type based on the selected loss method.
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7 Location This column displays the distance from OTDR to the event.

8 Refl. (dB) Displays the Reflectance in (dB) for each reflective event

9 Loss (dB) Displays the Insertion loss in (dB) for each event.

Keyboard Shortcuts
Available Trace600 keyboard shortcuts:

Open Trace... Ctrl+O

Open Baseline... Ctrl+B

Next File Ctrl+N

Prev File Ctrl+P

Close Ctrl+F4

Save Ctrl+S

Add Event Ctrl+A

Next Event Down Arrow

Prev Event Up Arrow

Delete All Events Shift+Del

Restore Event Shift+Insert

Move Active Cursor Left / Right Arrows

Zoom in Horizontally (Shift+Up Arrow)

Zoom out Horizontally (Shift+Down Arrow)

Zoom in Vertically (Ctrl+Up Arrow)

Zoom out Vertically (Ctrl+Down Arrow)

Un-Zoom F6

Re-Zoom F7

A-B Cursor F4
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Section 3: Transferring Trace Files to a PC

Traces Saved with M600 or M100 OTDR
Trace files saved with M600 or M100 OTDR are transferred to a PC using the supplied ImageMate™ 
USB 2.0 Reader/Writer and CompactFlash™ memory card.

Transferring Traces

To transfer trace files to a PC perform the following steps.

1 Connect the supplied ImageMate USB Reader/Writer to a USB 2.0 port on your PC while 
Windows® is running.

2 Windows will automatically recognize the ImageMate Reader/Writer and display it as [Removable 
Disk] in the [My Computer] folder.

3 Insert the CompactFlash card with saved test data in the ImageMate Reader/Writer.

4 Double-click on the [Removable Disk] icon to display saved trace files.

5 Using Windows commands, copy the desired trace files to your PC.

 Important:  To avoid data loss or malfunctions of your computer or ImageMate Reader/Writer, 
it is important to use Windows [Eject] and [Unplug] commands before physically removing 
CompactFlash™ memory card and ImageMate Reader/Writer. Refer to the following sections 
for details.
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Removing CompactFlash™ Memory Card 

Perform the following steps before removing a CompactFlash™ memory card from the ImageMate 
Reader/Writer:

1 Double-click on the [My Computer] icon to open the [My Computer] folder.

2 Right click on the [Removable Disk] icon.

3 From the pop-up menu, select the [Eject] command.

4 Pull the CompactFlash memory card out of the ImageMate USB Reader/Writer.

Disconnecting ImageMate USB Reader/Writer

You don’t need to shut down your computer to disconnect the ImageMate USB Reader/ Writer, but 
you should never remove the device from the USB port without first reading the steps below. If a 
drive window is open, or the ImageMate Reader/ Writer is active, close any associated windows 
before attempting to remove the Reader/ Writer.

Use the [Add/Remove Hardware] command in Control Panel or [Safe to Remove Hardware] 
hotplug icon in the notification area of the taskbar to safely remove the ImageMate Reader/ Writer 
before unplugging. The notification area is to the right of the taskbar where you usually see the 
current time displayed.

1 In the notification area, right-click on the [Safe to Remove Hardware] hotplug icon.

2 Select the device you want to unplug, and then click [Stop].

3 When Windows notifies you that it is safe to do so, unplug the Reader/ Writer from your 
computer.
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Traces Saved with OFL 200 OTDR
Trace files saved with an OFL 200 OTDR are transferred to a PC using the Trace600 software. 
Files selection and transfer are done in the [OFL 200 File Transfer] dialog box, which is accessed 
from the Trace600 [File] menu.

OFL 200 File Transfer Dialog Box

The [OFL 200 File Transfer] dialog box consists of several windows, numeric/text fields, and 
control buttons that allow you to perform the following tasks:

• Select all or multiple trace files for transferring to a PC.

• Remove all or multiple trace files from the transfer list.

• Rename trace files to be transferred.

• Renumber trace files to be transferred.

• Add information required for traces identification

The table below and Figure 3-1 describe the [OFL 200 File Transfer] dialog box features.

Ref # Feature Description
1 [OFL 200 Files] window Displays a list of trace files saved with an OFL 200 OTDR.

Note:  If trace files are not displayed, select the appropriate 
Com Port, and then click on the [Refresh] button.

2 [Com Port] pull down list Click on the [Down arrow] button at the end of the [Com Port] 
pull down list to display the available options.
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3 [Refresh] button After the appropriate Com Port is selected, click on this button 
to display a list of trace files in the [OFL 200 Files] window.

4 [Select All] button Allows selecting all trace files displayed in the [OFL 200 Files] 
window.
Note: To select or deselect files individually, click on the 
desired file name in the [OFL 200 Files] window.

5 [Select None] button Allows deselecting all files.
6 [Transfer Files] button Click on this button to start transferring.
7 [Close] button Click on this button to close the [OFL 200 File Transfer] dialog 

box.
8 [Destination Files] window This window displays the files as they will appear on the PC.

9 [Change Cable ID] check 
box

Check this box if you need to rename transferred trace files.

10 [Cable ID] text field This is a text field where you enter a new name for transferred 
traces (if needed).

11 [Fiber Number] check box Check this box if you need to renumber transferred trace files.
12 [Fiber Number] numeric 

field
This is a numeric field where you enter a starting number 
for transferred traces (if you need to renumber transferred 
traces).

13 Trace data text fields This section contains text fields where you enter all 
information you need to identify a cable.
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Figure 3-1: OFL 200 File Transfer Dialog Box.
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Transferring Traces

To transfer trace files from the OFL 200 OTDR to your PC:

1 Turn the OFL 200 OTDR on.

2 Connect the OFL 200 to your PC using the supplied serial cable.

3 You should see the [Remote] soft key label on the OFL 200 display.

 Press the [Remote] soft key on the OFL 200.

 Note:  On some computers the COM port will not turn on until step 5. In this case the [Remote] 
soft key will not be available until a warning message is displayed during step 5. Press the 
[Remote] soft key on the OFL 200 at that time. Please continue to step 4.

4 Open the Trace600 software.

5 From the Trace600 [File] menu, select the [Transfer files from OFL 200] command.

 Note: You may experience several seconds delay until the [OFL 200 File Transfer] dialog box 
is displayed (see Figure 3-1). 

6 From the displayed list, select the files to be transferred. Refer to the section titled “OFL 200 
File Transfer Dialog Box” for details.

7 Click on the [Transfer Files] button to start.

8 The [Browse for Folder] screen will be displayed. Navigate to the desired destination, and then 
click on the [OK] button.

• If needed, you may create a new folder by clicking on the [New folder] button.
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 Note:  Occasionally the New Folder will not be editable after creating. If this happens, right-
click on the New Folder icon and select the [Rename] command from the displayed pop-up 
menu.

9 While transfer is in progress, you will see the [Saving Files] screen.

• If needed, you may stop transferring at any time by clicking on the [Cancel] button.

10 When the transfer progress line indicates that files are saved on your PC, the [Cancel] button 
changes to [Done]. 

11 Click on the [Done], and then on the [Close] button.

Transfer progress line

Transfer progress line
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Section 4: Managing Trace Files

Single Trace or Trace Pair?
Trace600 offers two options for opening and closing trace files. Depending on the selected option, 
a trace file or trace files in wavelength pairs (dual-wavelength trace file pair) may be opened and 
closed within the current folder.

If the Single-wavelength option is enabled, then trace files will be opened and closed one-at-a-time. 
If the Dual-wavelength option is enabled, then trace files will be opened and closed in wavelength 
pairs (files with the same name and fiber type but different wavelengths).

For example:

If a folder contains files named “FIBER001.M85” (multimode, 850 nm) and “FIBER001.M13 
(multimode, 1300 nm)”, and in the file open dialog box the “FIBER001.M85” file is selected for 
opening, then Trace600 will automatically open both files. It doesn’t matter which file in a pair 
is selected first.

In addition to the current trace or pair, Trace600 allows you to open a baseline trace or pair for 
comparison with the current trace. If a dual trace pair and a dual baseline trace pair are opened, 
a total of four traces can be displayed at one time.
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Opening Trace Files

Opening a Single Trace

1 From the [View] pull down menu, select the [Options] command to display the [Options] dialog 
box.

2 Select the [Single-wavelength] option, and then click on the [OK] button. 

3 There are two ways to open a single trace file:

• From the [File] pull down menu, select the [Open Trace] command

OR

• Click the [Open] icon on the Toolbar

4 When the [Open Trace File] window is displayed, locate the drive and directory containing trace 
files.

5 From the displayed list of files, select the trace file you want to open.

6 Click on the [OK] button to open the file.

Select to open a single trace file
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Opening a Trace Pair

1 From the [View] pull down menu, select the [Options] command to display the [Options] dialog 
box.

2 Select the [Dual-wavelength] option, and then click on the [OK] button. 

3 There are two ways to open a trace pair:

• From the [File] pull down menu, select the [Open Trace] command

OR

• Click the [Open] icon on the Toolbar

4 When the [Open Trace File] window is displayed, locate the drive and directory containing trace 
files.

5 From the displayed list of files, select the trace file you want to open.

6 Click on the [OK] button to open the file.

Select to open trace files in 
wavelength pairs
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Opening Previous or Next Traces

After you open a single trace or trace pair, you may use the [Prev File] and [Next File] commands 
to display the previous or following trace or trace pair in the current folder.

There are three ways to display the previous or following trace or trace pair:

1 From the [File] pull down menu, select the [Next File] or [Prev File] command.

2 Click the [Next File] or [Prev File] icon on the Toolbar.

3 Use the shortcuts: [Ctrl+N] - next trace; [Ctrl+P] - previous trace.

Comparing Traces with a Baseline Trace
Trace600 allows you to open a baseline trace or pair for comparison other traces with the current 
baseline trace or pair. If a dual baseline trace pair and a dual trace pair are opened, a total of four 
traces can be displayed at one time.

1 From the [View] pull down menu, select the [Options] command to display the [Options] dialog 
box. From this dialog box, select Single-wavelength (or Dual-wavelength) option, and then 
choose [OK]. 

2 From the [File] pull down menu, select the [Open Baseline] command.

• When the [Open Trace File] window is displayed, locate the drive and directory containing 
trace files.

• From the displayed list of files, select the trace file you want to open.

• Click on the [OK] button to open the file.
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3 From the [File] pull down menu, select the [Open Trace] command.

• When the [Open Trace File] window is displayed, locate the drive and directory containing 
trace files.

• From the displayed list of files, select the trace file you want to open.

• Click on the [OK] button to open the file.

4 Click on the [Prev File] or [Next File] button to open the previous or following trace file or file 
pair in the current folder.

Note:  The [Prev File] and [Next File] commands will not affect the baseline trace(s). You can open 
one trace (or trace pair) as a baseline trace and compare it to other traces in the current folder.
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Closing Files with Changes
Two options are available for closing trace files with changes: [Save Automatically] and [Ask 
“Save Changes?”].

[Save Automatically] option [Ask “Save changes?”] option

If a trace file has been edited and not 
saved, it will be saved automatically 
before closing.

If a trace file has been edited and not saved, 
a dialog box will appear prompting you to save 
changes before closing. 

To specify how trace files will be closed perform the following steps.

1 From the [View] pull down menu, select the [Options] command to display the [Options] dialog 
box.

 

2 Select the desired option, then click on the [OK] button.
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Section 5: Analyzing Traces

Moving Cursors and Zooming
The [A] and [B] cursors may be positioned to measure the insertion loss, power level (if applicable), 
reflectance (if applicable), attenuation (if applicable), and distance between any two points on 
a trace.

To make cursor positioning easier, Trace600 provides tools and commands for viewing different 
parts of a trace graph at various magnifications. [Zoom In] and [Zoom Out] commands let you 
magnify or reduce the display of any area in the [Trace graph] window.

Trace600 zooms horizontally around the active cursor and vertically from the trace level at the 
active cursor.

Selecting the Active Cursor

To make a cursor active, do one of the following:

• In the [Trace graph] window, click on the desired cursor line or label.

• From the Toolbar, click on the [Cursor] button    to toggle between cursors.

• From the [View] pull down menu, select the [A-B Cursor] command to toggle between 
cursors.

• Press the [F4] key on your keyboard to toggle between cursors.

Once the active cursor is selected, it can be moved along the trace graph.
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Moving the Active Cursor

To move the active cursor, do one of the following:

• Position the mouse pointer on a cursor line or cursor label, then click-and-drag along the trace 
graph.

• Use the [Left] and [Right] keyboard arrow keys.

Note:  The [A] cursor cannot be moved beyond the [B] cursor location, and vice versa.

Zoom In and Out of a Trace

You can magnify or reduce the trace display performing one of the following:

• From the Menu bar, select the [View] pull down menu, and then choose the desired Zoom 
command.

Zoom in horizontally around the active cursor.

Zoom out horizontally around the active cursor.

Zoom in vertically from the trace level at the active cursor.

Zoom out vertically from the trace level at the active cursor.

 Note:  Each click magnifies the view to the next preset percentage until the limit of magnification 
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is reached.

• From the Toolbar, click on the corresponding Zoom button

 

Un-zoom and Re-zoom the Trace Display

In the zoomed view, Trace600 always displays the active cursor area. The [Un-zoom] and [Re-zoom] 
commands allow you to display different areas of a trace graph at the same level of magnification. 
If you need to un-zoom, move the active cursor, and then re-zoom, Trace600 will display the new 
position of the active cursor at the previous zoom level.

Perform the following steps:

1 In the [Trace graph] window, use the [Zoom In] and [Zoom Out] commands to set the desired 
level of magnification.

2 Click on the [Un-zoom] button to display the trace view at 100%.

3 Relocate the active cursor as needed (or toggle between A and B cursors).

4 Click on the [Re-zoom] button to display the new cursor location at the previous zoom level.

Note:  When you toggle between [A] and [B] cursors in the magnified view, the view changes 
accordingly to display area around the active cursor.
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Selecting Loss Method
For analyzing traces and adding events, Trace600 offers various Loss methods. The following table 
gives a summary of the available methods.

Loss Method (and applications) Measured parameters # of 
cursors 

# of LSA 
lines*

Two Point (general purpose) Insertion loss between any 2 
points of a trace

2 0

Single Event (used to analyze connections, 
splices, faults, etc.)

Location, Reflectance, Insertion 
loss of any Reflective or Non-
Reflective event

1 2

Multiple Event (used if two or more events 
are too close to use other methods)

Location and Insertion loss of 
multiple events

2 2

Fiber Attenuation (used to measure dB/km 
of fiber between events)

Attenuation per km ratio of any 
segment of a trace with no events

2 2

Start - No Launch Cable (used to set start 
of fiber level)

Starting location and level of a 
trace

1 1

End - No Receive Cable (Used to set end 
of fiber level)

Location, Reflectance, and Trace 
level of the fiber end

1 1

*LSA Line - least squared approximation segment line. Used to reduce the effects of noise while 
calculating insertion loss, trace level, and attenuation.
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To select the desired Loss method perform the following: 

1 From the Menu bar, choose the [Events] pull down menu.

2 Choose the [Loss Method] command to display a list of the available options.

3 Select the desired Loss method.

Positioning Cursors Correctly 
Depending on the selected Loss Method, you will need to position cursors and adjust LSA lines 
(if applicable) properly. The following graphs illustrate position of cursors and LSA lines for the 
available Loss methods.

Two Point Loss Method

1 Position the left cursor at the start 
of the event.

2 Position the right cursor beyond the 
event where the trace returns to a 
constant slope.

3 Read the insertion loss measurement 
displayed in the [Cursors data] 
window.

Left cursor Right cursor
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Single Event Loss Method

1 Position a cursor at the start of the event.

2 If required, adjust the right LSA line so the Near Right boundary located beyond the event where 
the trace returns to a constant slope.

3 Read the insertion loss measurement displayed in the [Cursors data] window.

Or

4 From the [Events] pull down menu, choose the [Add Event] command to save.

Left LSA line Right LSA line

Cursor Near Right boundary
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Multiple Event Loss Method

1 Position the left cursor at the start of the first event.

2 Position the right cursor at the start of the last event.

3 If required, adjust the right LSA line so the Near Right boundary located beyond the event where 
the trace returns to a constant slope.

4 Read the insertion loss measurement displayed in the [Cursors data] window.

Or

5 From the [Events] pull down menu, choose the [Add Event] command to save.

Left LSA line Right LSA line

Near Right boundary

Right cursor
Left cursor
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Fiber Attenuation Loss Method

This method is used just for analyzing a trace.

1 Position left and right cursors on the trace as needed.

2 Read the insertion loss (dB/km) measurement displayed in the [Cursors data] window.

Left cursor Right cursor
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Start (No Launch Cable) Loss Method

1 Position the left cursor at the beginning of the trace (0 meters).

2 If required, adjust the right LSA line so the Near Right boundary located beyond the reflection 
where the trace returns to a constant slope.

3 Read the trace level measurement displayed in the [Cursors data] window.

Or

4 From the [Events] pull down menu, choose the [Add Event] command to save.

Cursor at the origin

Near Right boundary

Right LSA line
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End (No Receive Cable) Loss Method

1 Position the Left cursor at the start of the Far-end reflection.

2 If required, adjust the left LSA line.

3 Read the trace level measurement displayed in the [Cursors data] window.

Or

4 From the [Events] pull down menu, choose the [Add Event] command to save.

Left LSA line

Left Cursor
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Adjusting LSA Lines
If events of a trace are located very close to each other, you may have to adjust the LSA Lines. The 
graphs below illustrate an example of the right LSA line before and after the adjustment.

To adjust LSA lines, position the mouse pointer over an LSA line boundary, then click and drag 
to the desired location.

Note:  if you need to restore the original LSA lines lengths values, choose the [Restore LSA 
Defaults] command from the [Events] pull down menu.

LSA Line before the adjustment LSA Line after the adjustment
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Adding Manual Events 
To add manual events, perform the following steps:

1 From the [Events] pull down menu, select the [Add Event] command.

2 The [Add Event] dialog box opens displaying the event data that will be added to the [Event 
table] and allowing you to add a comment.

3 Type a comment in the Comment text field (maximum 94 characters) if needed.

4 Choose OK to save. Trace600 automatically places an event mark in the [Trace graph] window 
and event data in the [Event table] window.

Figure 5-1: Add Event Dialog Box.

Comment text field - this is the 
text field where you add comments 
if needed.

Event data - this information will 
be added to the [Event table]
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Editing Comments
To edit a comment, do one of the following:

1 In the [Event Table], select the desired event by clicking on it.

• From the [Events] pull down menu, select the [Current Event] to display the [Comments] 
submenu.

• From the [Comments] submenu, select the [Edit comment] command to display the [Edit 
Event] dialog box (see Figure 5-1).

• Edit comments as needed.

• Click on the [OK] button to save changes.

OR

2 In the [Event Table], select the desired event by clicking on it.

• Right-click the selected event, to display the [Comments] submenu.

• From the [Comments] submenu, select the [Edit comment] command to display the [Edit 
Event] dialog box (see Figure 5-1).

• Edit comments as needed.

• Click on the [OK] button to save changes.
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Deleting Events
To delete an event, do one of the following:

1 In the [Event table], select the desired event by clicking on it.

• From the [Events] pull down menu, select the [Current Event] to display the [Comments] 
submenu.

• From the [Comments] submenu, select the [Delete] command

OR

2 In the [Event table], select the desired event by clicking on it.

• Right-click the selected event, to display the [Comments] submenu.

• From the [Comments] submenu, select the [Delete] command
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Editing Trace Information

Editing a Single Trace

Trace600 allows you to edit trace information and certain setup parameters. This is done in the 
[Edit Trace Information] dialog box.

1 There are three ways to display the [Edit Trace Information] dialog box.

• From the [File] pull down menu, select the [Edit Trace Info] command.

• From the Toolbar, click on the [Info]   button.

• Click on the  button.

2 When the [Edit Trace Information] dialog box is displayed, edit text fields as needed.

3 Choose [OK] to save changes.

Refer to the following description and Figure 5-2 for details.

Ref # [Edit Trace Info.] 
dialog box feature

Description

1 [Text Info] section This section contains text fields where you enter all 
information you need to identify a trace.

2 Date field Click on the [Down arrow] button at the end of the Date field  
to display a pop-up calendar and edit test date as needed.

2 Fiber number field Allows you to change the fiber number.
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Figure 5-2: Edit Trace Information Dialog Box.

4 Group index Allows you to change the Group index value.

5 BackScatter coefficient Allows you to change the BackScatter coefficient value.

6 Reflectance threshold Allows you to change the Reflectance threshold value.

1
4

3

5

2

6
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Batch Editing

The Batch editing feature allows you to edit all or selected test properties (such as fiber name, 
fiber number, test site data, and comments) in multiple trace files in the current folder. This is 
done in the [Batch Edit] dialog box. The [Batch Edit] dialog box consists of several windows and 
control buttons. The table below gives a summary of the [Batch Edit] dialog box features (see 
Figure 5-3).

Ref # Feature Description
1 [Drive] window Allows you to navigate to the desired folder
2 [Files in Folder] window Displays all trace files in the currently selected folder
3 [Files to Edit] window Displays all trace files added to the batch edit list
4 [Add] button Adds a single trace or multiple traces to the batch edit list
5 [Add All] button Allows you to add all traces to the batch edit list
6 [Remove] button Allows you to remove a single trace or multiple traces from the 

batch edit list
7 [Remove All] button Allows you to remove all traces from the batch edit list
8 Properties check boxes Select corresponding check boxes to activate editable text fields
9 Text editable fields This section contains text fields where you enter all information 

you need to identify traces
10 [Clear all Text] button Removes all text from the text fields section
11 [OK] button Click on this button to complete changes
12 [Exit] button Closes the [Batch Edit] dialog box
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Figure 5-3: Batch Edit Dialog Box.

1 2 3
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To edit all or selected files, perform the following:

1 From the [File] pull down menu, select the [Batch Edit] command to access the [Batch Edit] 
dialog box. 

2 In the [Drive] window, locate and select the desired folder.

3 Double-click on the selected folder to open it.

4 All trace files in the open folder will be displayed in the [Files in Folder] window.

5 From the [Files in Folder] window, add the desired traces to the batch edit list, which will be 
displayed in the [Files to Edit] window. Use the [Add] or [Add All] buttons for adding trace 
files.

• To add trace files individually:

 Double-click the desired trace name listed in the [Files in Folder] window. The trace name 
added to the batch edit list will appear in the [Files to Edit] window.

 OR

 Click on the desired trace name listed in the [Files in Folder] window, then click on the 
[Add] button. The trace name added to the batch edit list will appear in the [Files to Edit] 
window.

• To add all trace files in the current folder to the batch edit list, click on the [Add All] button. 
The added trace names will appear in the [Files to Edit] window.

6 If you need to remove trace files from the batch edit list displayed in the [Files to Edit] window, 
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use the [Remove] or [Remove All] buttons.

• To remove trace files from the batch edit list individually:

 Double-click the desired trace name displayed in the [Files to Edit] window. The trace name 
listed in the [Files to Edit] window will be removed.

 OR

 Click on the desired trace name displayed in the [Files to Edit] window, then click on the 
[Remove] button. The trace name listed in the [Files to Edit] window will be removed.

• To remove all trace files from the print list displayed in the [Files to Edit] window, click on the 
[Remove All] button. All trace names listed in the [Files to Edit] window will be removed.

7 To activate editable text fields, select corresponding check boxes.

8 Edit text fields as needed.

9 Choose OK to complete changes.
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Section 6: Printing Trace Reports

Selecting a Printer
The [Printer Setup] command, allows you to select a printer and set up the printing options.

1 From the [File] pull down menu, choose the [Printer Setup] command. The [Print Setup] dialog 
box will be displayed (see Figure 6-1).

2 Click on the [Down arrow] button at the end of the [Name] pull down list to display the available 
printers.

3 From the displayed list, select the 
desired printer.

 Note: If you have a PDF printer installed, 
you may select it for producing trace 
reports in the PDF file format. 

4 I f needed, you may click on the 
[Properties] button to display the 
[Printing Preferences] dialog box and 
change settings that affect the way 
documents are printed. 

5 When all settings are complete, click 
on the [OK] button.

2 4

Figure 6-1: Print Setup Dialog Box.
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Printing a Single Trace Report
There are two ways to print a single trace currently displayed in the [Trace graph] window:

• Click on the Toolbar Print    icon. Clicking this icon allows you to print directly to the 
default printer.

OR

• From the [File] menu, select the [Print] 
command. The [Print] dialog box will be 
displayed (see Figure 6-2).

 Activating this command allows you 
to select a printer and set up printing 
preferences.

• Select the desired printer by clicking on its 
icon. Depending on the selected printer, 
a variety of tabs that represent Printing 
Preferences will appear on the top of the 
[Print] dialog box.

• Click each tab to see the available 
choices. Change options as needed.

• When all settings are complete, click on 
the [Print] button.

Figure 6-2: Print Dialog Box.
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Printing Multiple Trace Reports - Batch Printing
For printing multiple trace reports, Trace600 provides the Batch Print feature, which simplifies printing 
operations by allowing multiple trace reports to be printed automatically. Using the [Batch Print] 
command, all trace files that require printing can be selected and processed at once. This is done in 
the  [Batch Print] dialog box.

Batch Print Dialog Box

The table below gives a summary of the [Batch Print] dialog box features (refer to Figure 6-3).

Ref # Feature Description

1 [Drive] window Allows you to navigate to the desired folder

2 [Files in Folder] window Displays all trace files in the currently selected folder

3 [Files to Print] window Displays all trace files added to the print list

4 [Trace Preview] window Allows you to view the selected trace graph

5 [Cover Page] check box Check this box if you prefer to print a summary page 

6 [Cover Page Setup] 
button

Allows you to access the [Cover Information] dialog box and add 
necessary information to a summary page

7 [Add] button Adds a single trace or multiple traces to the print list

8 [Add All] button Allows you to add all traces to the print list

9 [Remove] button Removes a single trace or multiple traces from the print list

10 [Remove All] button Allows you to remove all traces from the print list
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11 [Zoom] arrow buttons Allows you to set up a zoom level for all traces in the print list

12 [Print Files] button Sends the created batch print job to a printer

13 [Exit] button Closes the [Batch Print] dialog box

Figure 6-3: Batch Print Dialog Box.

1 2 3
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Selecting Traces for Batch Print

1 From the [File] menu, select the [Batch Print] command to access the [Batch Print] dialog box 
(refer to Figure 6-3).

2 In the [Drive] window, locate and select the desired folder.

3 Double-click on the selected folder to open it.

4 All trace files in the open folder will be displayed in the [Files in Folder] window.

5 If you need to view a trace graph before adding a trace file to the print list, use the [Trace 
Preview] window.

• Click on the desired trace name listed in the [Files in Folder] window to display the selected 
trace graph in the [Trace Preview] window.

6 From the [Files in Folder] window, add the desired traces to the print list, which will be displayed 
in the [Files to Print] window. Use the [Add] or [Add All] buttons for adding trace files.

• To add trace files individually:

 Double-click the desired trace name listed in the [Files in Folder] window. The trace name 
added to the print list will appear in the [Files to Print] window.

 OR

 Click on the desired trace name listed in the [Files in Folder] window, then click on the [Add] 
button. The trace name added to the print list will appear in the [Files to Print] window.

• To add all trace files in the current folder to the print list, click on the [Add All] button. The 
added trace names will appear in the [Files to Print] window.
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7 You may set horizontal and vertical zoom level for all trace files in the current folder. The zoom 
level you set for one trace applies to all traces in the current folder.

• Use the [Zoom] arrow buttons to set horizontal and vertical zoom level.

8 If you need to remove trace files from the print list displayed in the [Files to Print] window, use 
the [Remove] or [Remove All] buttons.

• To remove trace files from the print list individually:

 Double-click the desired trace name displayed in the [Files to Print] window. The trace name 
listed in the [Files to Print] window will be removed.

 OR

 Click on the desired trace name displayed in the [Files to Print] window, then click on the 
[Remove] button. The trace name listed in the [Files to Print] window will be removed.

• To remove all trace files from the print list displayed in the [Files to Print] window, click on the 
[Remove All] button. All trace names listed in the [Files to Print] window will be removed.

9 To create a Cover page for trace reports, click on the [Cover Page Setup] button (refer to the 
section titled “Creating a Cover Page” for more information).

10 To print a Cover page in addition to trace reports, verify that the [Include Cover Page] check 
box is selected.

11 When all settings are complete, click on the [Print Files] button to send the batch print job 
to a printer.
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Creating a Cover Page for your Batch Print Job

Trace600 allows you to create a cover page for your multiple printing. To create a cover page, 
perform the following steps.

1 From the [File] menu, select the [Batch Print] command to access the [Batch Print] dialog box 
(refer to Figure 6-3).

 Note:  When you access the [Batch Print] dialog box, the [Cover 
Page Setup] function is not available - the [Cover Page Setup] 
button is grayed out. To make the [Cover Page Setup] button 
active, you need to create a batch print list. At least one trace 
file needs to be added to a print list, which is displayed in the 
[Files to Print] window.

 To print a cover page in addition to trace reports, verify that the [Include Cover Page] check 
box is selected.

2 Create a batch print list (refer to the section titled “Selecting Traces for Batch Printing”).

3 Click on the [Cover Page Setup] button to access the [Cover Information] dialog box.

 The [Cover Information] dialog box is divided into several sections with editable text fields as 
follows.

Report Title field 
This is a text field where you enter a 
title for your batch print job.
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Company Information section
This section contains text fields 
where you enter company name 
and address.

Cable Information section
This section contains text fields 
where you enter all information you 
need to identify a cable.
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Job Description section
This section contains text fields 
where you enter the information 
required to identify a job.

5 When you finish entering all the necessary information, click on the [OK] button to return to 
the [Batch Print] dialog box.
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Thank you for choosing Noyes Test & Inspection

16 Eastgate Park Road 
Belmont, NH 03220  
Phone: 800-321-5298
 603-528-7780
Fax: 603-528-2025
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